
QLab 2 User's Guide

QLab 2
User's Guide

Last modified: 11 January 2012

QLab Documentation Copyright ©2010 Figure 53, LLC Page 1 of 77



Related Tutorial

Tutorial 1-1: Welcome to QLab

Introduction to QLab 2
Welcome to QLab! QLab makes it simple to create rich multimedia designs for live performances and installations.
QLab's event-driven media sequences are perfect for sound design, video projection design, or anything where you
need to trigger media playback in a precise and flexible manner. Uses include: theatrical performances, dance
performances, church productions, advertising displays, museum installations, and more.

This documentation will give you a detailed introduction to the QLab application. We encourage you to contribute
additional tutorials, hints and tips, and any other supplemental information you feel is useful to the QLab Wiki,
located at http://wiki.figure53.com/.

Video Tutorials

A series of video tutorials are also being created for QLab. You can find the
videos (and a tutorial workspace) on our website at http://figure53.com/qlab/
tutorials/

Links to the video tutorials will also appear within this documentation, like so:

Requirements

QLab 2 requires Mac OS 10.5.2 or later and QuickTime 7.3 or later.

The video features require a graphics card that supports Quartz Extreme and Core Image.

Transition from version 1.x

QLab 2 may be safely installed on a machine running QLab version 1.x; the two programs will not interfere with
each other.

QLab 2 will not read QLab 1.x workspace files. QLab 2 workspace files now use the file extension ".cues".

QLab 2 is designed to offer advanced functionality far beyond what is possible with QLab 1. QLab 2 therefore
requires more powerful hardware than QLab 1. Machines which are adequate for QLab 1 may not be adequate for
QLab 2. Please always test your equipment to determine its capacity.
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What's New
QLab version 2 features many powerful new features. Highlights include:

New GUI.
QLab 2 offers a single integrated layout with streamlined controls to help you work faster.

48 channel output.
Each Audio Cue now supports up to 48 independent channels of output.

Sample-accurate audio synchronization.
QLab now provides guaranteed sample-accurate sync across all Audio Cues assigned to the same output
device. You can pause and play the entire workspace, and it will all remain sample-accurate synced.

Audio waveform display.
Visually trim the head and tail of your audio files. Visually set a looping section of the file. Even add a fade
envelope directly to the waveform.

Revamped vamping.
Vamping doesn't get any easier than this: set up a loop in your cue and fire a Devamp Cue when you want to
move past the loop. You can even build an infinite number of looped sections into a single piece of music by
"stitching" together multiple Audio Cues. (Remember: it's all sample-accurate synced!)

Draw your own fade curves.
Give your fades sharp edges or gentle curves: it's up to you.

Animate your videos.
The new Animation Cue allows you to animate opacity, translation, scale, and rotation.

Camera Cues.
Add a live video feed into your workspace. Animate it just like videos from a file.

Custom video rendering: Core Image filters and more.
You can render your videos and camera feeds through your own Quartz Compositions. The possibilities are
endless.

Trigger cue lists from timecode.
QLab can follow either MIDI Timecode or Linear Timecode—or both at the same time. Each cue list can follow a
different timecode source.

Generate MIDI Timecode.
Drop in an MTC Cue and tell it where to send the timecode.

Powerful scripting.
Use the Script Cue to control other applications on your Mac, providing tremendous flexibility and power.
Thorough scripting hooks also let you control QLab with AppleScript, Python, or Ruby.

Overhead does not accrue.
Have you ever tried to chain together a bunch of short cues and by the end of it the timing was slightly off?
This is because in QLab 1 the small overhead of firing each cue would add up. In QLab 2, however, the
overhead does not add up. No matter how many you chain together, the last will always be as accurate as the
first.
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Related Tutorial

Video tutorial 1-3

Basic Concepts
QLab offers powerful, flexible and intuitive live show control. With QLab you can play back
audio and video with precision and reliability day after day, night after night. More than
simple playback, QLab is an automation system which allows you to construct complex
sequences of volume changes, animations, and MIDI messages in an event-based
framework. Extremely subtle media sequences can be built quickly and then triggered with the simple press of a
button.

Cues

Cues are the fundamental building block of QLab. Each kind of cue performs a different kind of action. For example,
an Audio Cue will play an audio file, a Pause Cue will pause other cues, and a MIDI Cue will send a MIDI message.

A detailed description of how cues operate may be found in the Cue documentation.

Cue lists

Cue lists are ordered collections of cues. All cues are in one and only one cue list. You may organize the order in
which cues will play by reordering their position in the cue list. Each cue list has a single playback position. The
playback position is the next cue that will run when the cue list is triggered. Triggering, or "firing", a cue list
advances this playback position. When the playback position reaches the end of the cue list, firing the cue list will
cause no more actions until the playback position is reset.

Cue sequences

Understanding the behavior of cue sequences is fundamentally important to the effective use of QLab.

When a cue list is fired the cue at the current playback position is played. If the auto-continue ( ) or auto-follow (

) parameter of this cue is enabled the subsequent cue will also be fired (after any specified waiting period has

elapsed). This process is repeated until a cue is reached that does not auto-continue or auto-follow. A consecutive
series of these connected cues is called a cue sequence.

Cue sequences are an important concept because they allow you to create a number of actions which will all occur
after firing a cue list a single time. Conceptually, a cue sequence is like a series of dominoes: knocking over the first
domino will cause all the dominoes to fall until a gap between dominoes is reached.

Playback position

Each cue list has only one playback position. The current playback position is indicated by the teardrop icon ( ).

You may select any cue in the list to make it the current playback position (including cues in the middle of a cue
sequence). When a cue list is fired the playback position is automatically advanced to the beginning of the next
sequence.

New in Version 2: QLab now allows you to select and edit cues without changing the playback position of the cue
list. This can be handy for a designer who wishes to edit a previous or upcoming cue without disturbing the
playback position for an operator. This option may be turned on and off in the workspace preferences.
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While a cue list has only one playback position, it may have many active cue sequences. In other words, many
different series of dominoes may be falling within a cue list at any given time. Do not confuse the "currently falling
domino" in a cue sequence with the playback position of the cue list.
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Related Tutorial

Tutorial 1-4: The Workspace

Workspaces
Each document in QLab is called a workspace. A workspace is composed of a
collection of cue lists, which are in turn composed of a collection of cues.

Pictured below is a simple workspace with only two audio cues.

A simple workspace with two audio cues.
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The workspace window is divided into seven parts:
1. The toolbar.
2. The GO / On Deck / Notes panel.
3. The toolbox.
4. The current cue list.
5. The active cue panel.
6. The cue list drawer.
7. The inspector panel.

The components of a workspace.

The currently selected cue list is displayed in the center of the workspace window (#4). Pressing the "GO" button
fires the cue list, causing the cue at the current playback position to be triggered and the playback position to
advance. By default, pressing the space bar is equivalent to pressing the GO button. (You can change the GO key in
the workspace preferences.)

You may have more than one workspace open at a time. You may cut and paste (or drag and drop) cues from one
workspace to another.
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Workspace Subtopics:
• Adding cue lists
• Adding cues
• The components of a cue row
• Ordering cues
• Changing the time display mode
• Setting targets
• Navigating the cue list
• Bundling a Workspace
• The Toolbar

◦ Inspector Button
◦ Toolbox Button
◦ Active Cues Button
◦ Resetting the workspace
◦ Stopping all cues
◦ Loading a sequence
◦ Refreshing targets
◦ Showing/hiding group outlines
◦ Locking the workspace

Adding cue lists

A workspace may have an unlimited number of cue lists. Cue lists may be
viewed in the cue list drawer, which is accessed by pressing the drawer

toolbar button ( ). Cue lists may be added and removed using the

plus and minus buttons in the cue list drawer.

You may convert a Group Cue into a cue list by dragging the Group Cue
into the drawer. All the cues that were in the group will become part of
the new cue list. Similarly, cue lists dragged into other cue lists are
converted into Group Cues. (Learn more about groups with the Group Cue
documentation.)

The cue list drawer.
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Adding cues

New cues are added using the toolbox. See the toolbox documentation for details.

The components of a cue row

Each row of a cue list displays information about one cue. This information includes the cue's status, type, number,
name, target, timing and duration information, and continue mode.

The status of the cue may be one of four values:

Status Icon Meaning

Running The cue is currently running or waiting.

On
Deck

The cue has been loaded and is ready to be fired.

Broken The cue has an invalid or incomplete setting and can not be
played.

Blank (no
icon)

The cue is not running, loaded, or broken.

The status may also indicate that the cue is the current playback position of the cue list:

Status Icon Meaning

Running Playback
Position

Same as table above, but the cue is also the playback
position for this cue list.

On Deck Playback
Position

Same as table above, but the cue is also the playback
position for this cue list.

Broken Playback
Position

Same as table above, but the cue is also the playback
position for this cue list.

Playback Position The cue is the current playback position. The cue is not
running, loaded, or broken.

The other cue properties displayed in a cue row are described in the Cue documentation.

Ordering cues

Cues may be reorganized within cue lists by dragging and dropping them to new locations. If a dragging operation
is invalid, such as attempting to drag a Group Cue within itself, QLab will not allow the operation. You may select
multiple cues to drag at once by holding down the shift key or the command key as you click each cue you want to
drag.

Dragging operations, along with all other changes to the cues in a QLab workspace, are undoable.
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Changing the time display mode

The three columns in the workspace that display time information can display it in one of two modes: time elapsed (
) or time remaining ( ). Click on the time mode button in the column header to toggle the display mode for that

column.

Setting targets

Many cues in a workspace have targets. The exact meaning of the target depends upon the type of cue, but no cue
may have more than one target. For cues that have targets, the target is either a file or another cue. This target
represents the object upon which the cue acts in some way. For example, a Start Cue will start its cue target and an
Audio Cue will play its audio file target.

You can set a target in several ways. For cues that operate upon other cues, you can either drag the desired target
cue onto the receiving cue, or you can enter the number of the target cue directly via the keyboard.

For cues that operate on files, you can drag the file from the Finder onto the receiving cue to set the target.
Alternately, you can click on the arrow button ( ) in the cue row. This will bring up a dialog box through which you

can pick the file you want to use for the cue.

By default pressing 'T' on the keyboard will edit the target of the currently selected cue.

Cues will attempt to determine if they can accept the target you are dropping on them. In the case of a Audio Cue,
for example, it will attempt to determine if the file you are dropping is an audio file of a type that the cue can play.
If the Audio Cue can handle the file, a blue rectangle is drawn around the row in the cue list indicating that the file
will be accepted. If the file cannot be handled, no such rectangle will be drawn and the drop operation will not be
permitted.

Navigating the cue list

Several key commands are available to make navigating the cue list easier:

↓ Select the next cue (only when the cue list is selected).

↑ Select the previous cue (only when the cue list is selected).

+ Move to the top of the next sequence.

- Move to the top of the last sequence.

→ Expand the currently selected Group Cue.

← Collapse the currently selected Group Cue.

> Expand all Group Cues.

< Collapse all Group Cues.

Command-↓ Select the next cue.

Command-↑ Select the previous cue.

Command-→ Select the next inspector tab.

Command-← Select the previous inspector tab.
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Option-Command-↑ Move the playback position up.

Option-Command-↓ Move the playback position down.

Bundling a Workspace

In the process of building your workspace, you may have used media files from a variety of locations on your
computer. This can make it difficult to transfer your workspace to a new computer, or archive it for later use.

To address this problem, QLab offers a feature called "bundling". You may bundle any workspace using the "File" →
"Bundle Workspace..." menu item. When you bundle a workspace, QLab will first prompt you to enter a name and
destination for your bundled workspace. This name is used to create a new folder for your workspace. Your
workspace file and every media file referenced in your workspace are then copied to this new folder. All cues are
updated to use these new media files. The bundled workspace can then be easily transferred to a new machine.

The Toolbar

The workspace toolbar offers several useful controls for the workspace. You can customize the controls displayed in
the toolbar by selecting "View" → "Customize Toolbar..." or by right-clicking or control-clicking on the toolbar and
selecting "Customize Toolbar..."

Inspector Button

The Inspector Button displays or hides the cue inspector panel.

Toolbox Button

The Toolbox Button displays or hides the cue toolbox.

Active Cues Button

The Active Cues Button displays or hides the active cues panel.

Resetting the workspace

The "Reset All" toolbar button stops every cue in the workspace, resets the playback position of every cue list

to their first cue, and loads the first sequence of every cue list.

Stopping all cues

The "Stop All" toolbar button stops every cue in the workspace but does not alter the cue list playback

positions.

Pressing the escape key is equivalent to pressing the "Stop All" toolbar button in every open workspace.
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Loading a sequence

The "Load" toolbar button causes the sequence of cues starting at the currently selected cue to be loaded.

The "Load to Time" toolbar slider allows you to "fast forward" through the sequence at the playback position so it is
loaded to particular time.

A loaded cue has been prepared in every way possible to be started immediately. An Audio Cue, for example, will
load part of its sound file into a buffer to enable immediate audio playback.

When a cue list is fired and the playback position is advanced, the next cue sequence is loaded automatically.

Cues that are loaded and "on deck" display a yellow circle ( ) in their status column.

Refreshing targets

The "Refresh Targets" toolbar button causes all media files in the workspace to be reloaded. This can be

helpful if you are editing your media files in external applications while building the workspace.

Showing/hiding group outlines

The "Show/Hide Group Outlines" toolbar button allows you to...you guessed it, show and hide the group cue

outlines. This option is also available from the "View" → "Show/Hide Group Outlines" menu item.

Locking the workspace

You can use the "Lock" toolbar button to lock or unlock a workspace. When locked, you cannot change the

workspace.
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Toolbox
The Toolbox displays all available cue types. You can think of the Toolbox as a
cue factory: it is used to create each new cue in your workspace. You may create
new cues in one of three ways:

1. Dragging the cue from the Toolbox to your workspace.
2. Double clicking the row of the cue you want.
3. If the cue is in the first ten rows of the Toolbox you can use the

displayed command-key shortcut to create it.

You may rearrange the Toolbox by dragging the rows to new positions. This
allows you to change the command-key shortcut assigned to each cue. For
example, if you wish to use Command-1 for Audio Cues simply drag the Audio
Cue to the first row of the Toolbox.
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Tools
The Tools menu provides a variety of tools to operate on the currently selected cues in the workspace.

Tools Subtopics:
• Renumber Selected Cues
• Delete Numbers of Selected Cues
• Jump to Cue
• Cue-specific Tools

Renumber Selected Cues

Use the "Renumber Selected Cues" dialog to assign new
numbers to each currently selected cue in the workspace. Note
that cue numbers must be unique within the workspace, so the
Renumber tool will skip numbers that already exist.

Delete Numbers of Selected Cues

Use this command to immediately delete the numbers of all selected cues. Like all cue changes, this operation can
be undone.

Jump to Cue

Use the "Jump to Cue" dialog to select a specific cue in the
workspace. The selection will jump to the cue with the given
number.

Cue-specific Tools

Each cue may provide additional tools specific to the cue. This includes features such as copying and pasting
volume levels (a feature activated by the Pro Audio license). When a cue is selected in the workspace any specific
tools available for that type of cue will appear in the tools menu.
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Inspector
The Inspector describes every available parameter for the currently selected cue. The name, number, and target
information of the cue (which may be empty, depending on the cue) are always visible at the bottom of the
inspector panel. The bottom of the inspector panel is also colored according to whether the cue is broken or not.
The bottom band is colored red if the cue is broken, and green if it is ready to fire. Above this information are tab
views organizing all the parameters of the cue. For simple cues, only the Info and Triggers tabs are available. More
complex cues will provide other tabs that you may use to access all the cue settings.

Whenever you select a cue in the workspace, the inspector is updated to show the information for that cue.

Useful key commands for the inspector include:

Command-
→

Select the next inspector tab.

Command-
←

Select the previous inspector tab.

Tab Move from the cue list to the inspector. Move from field to field in the
inspector.

Inspector Subtopics:
• Info Tab

◦ Pre Wait and Post Wait
◦ Continue Mode
◦ Color
◦ Armed
◦ Notes

• Triggers Tab
◦ Hot Key Trigger
◦ MIDI Message Trigger
◦ Timecode Trigger
◦ Wall Clock Trigger

Info Tab

All cues share several basic parameters which are displayed in the inspector's first tab: the Info tab.
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Pre Wait and Post Wait

The Pre Wait and Post Wait parameters of a cue describe how long playback will pause before and after a cue is
fired. These wait times are useful for different circumstances.

The Pre Wait parameter, for example, is typically used in conjunction with a Group Cue that is set to fire all its
children simultaneously. Used this way, the Pre Wait parameter allows you to build an absolute timeline of cues.

In contrast, the Post Wait parameter is typically used to create a relative timeline of cues, simply by inserting waits
between several auto-continued cues in a sequence.

Continue Mode

You may set one of three continue modes:
do not continue

No additional cues are automatically fired after this cue is fired.

auto-continue
After this cue is fired, QLab waits for the duration specified by the
post wait (which may be zero) and then automatically fires the next
cue.

auto-follow
After this cue is fired, QLab waits for the exact duration of the cue's
action (whatever that may be), and then automatically fires the
next cue.

Auto-follow mode is commonly used, for example, for creating iTunes-
style playlists of music. The next cue will always be triggered precisely at
the moment that the current cue is complete.
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Color

The color parameter can be used to highlight important cues. Whichever color you choose will be used as a
background color in the cue list and also the list of active cues.

Armed

The "armed" parameter specifies with the cue will actually perform its action when it is fired. If the cue is disarmed,
the pre-wait, post-wait, and continue mode will still be honored, but the action of the cue itself will not be fired.

Notes

You can store arbitrary notes with each cue. These notes are displayed next to the GO button during playback.

Command-T will show the "Fonts" dialog box, where you can select custom fonts and colors to use for your notes.

You can also drag images into the notes.

Triggers Tab

In addition to the normal "GO" button method of firing cues, you can assign a variety of other triggers to each cue.
All of these triggers can be used simultaneously on one cue—you do not have to pick just one kind of trigger to fire
the cue.

Hot Key Trigger

You may assign a hot key to any cue. When you press this key, the cue will start.

Any key can be assigned to start any cue. You can also use key modifiers like option, shift, and control...but
command is reserved for menu items. QLab will warn you if you've assigned a key that is used in the workspace
preferences. You can assign these keys but they will not work until the workspace preferences are changed to avoid
the conflict.

MIDI Message Trigger

If you have the Pro MIDI License you may assign a MIDI Voice Message to trigger any cue. The cue will start when
QLab receives that MIDI message.
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You can use the "Capture..." button to easily assign a MIDI message to a cue. The first MIDI Voice Message
received after pressing the capture button will be assigned as the MIDI Trigger.

MIDI triggers can also be set to respond to any velocity or control value instead of a specific value. Simply enter the
word "any" into the second text field and the cue will be triggered for any incoming value.

Timecode Trigger

Each cue may be triggered using incoming MIDI timecode or Linear (SMPTE) timecode.

You may specify either the specific timecode when the cue should fire, or the real time in seconds.

After setting the timecode trigger for a particular cue you must also activate timecode for the cue list which
contains that cue. The cue list is where you specify the incoming timecode mode and source. Click on the cue list in
the cue list drawer to access the timecode settings in the inspector.

The Timecode settings for a cue list.

Wall Clock Trigger

You may assign a wall clock time to any cue. The cue will start at the given time.
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The active cue list.

Active Cues
The Active Cues panel shows a list of all currently running or paused cues in
the entire workspace.

Each row displays a progress slider, a pause/play button, and the elapsed
and remaining time of the cue.

If you select one of the active cues, the same command key shortcuts that
you use in the cue list will apply (i.e. stop, pause, and play).

The Pause All button pauses all currently running cues. The Play All button
will cause all currently paused cues in the workspace to start playing again.
The Pause All and Play All buttons do not disrupt synchronization; you can
pause the whole workspace and then play it again and the cues will remain
sample-accurate synced.
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Cues
Cues are the fundamental building block of QLab. Each kind of cue performs a different kind of action. For example,
an Audio Cue will play an audio file, a Pause Cue will pause other cues, and a MIDI Cue will send a MIDI message.

You can copy and paste cues within a workspace, or between different workspaces. You can also drag and drop cues
or entire cue lists between two workspaces.

When you copy a cue, QLab also stores a basic text summary of the cue on the clipboard. This means you can paste
basic information about the cue directly into spreadsheets or text documents.

Several basic properties are shared by most cues. These include the following:
Number

The number you assign to a cue may be any unique string, or may be empty. Examples of valid cue
numbers include: "1", "100", "10.5", "A", "BB", and "My long, drawn-out cue number". Cue Numbers
are always unique in a workspace.

Name
The name you assign to a cue may be any string, or may be empty.

Target
The target of a cue, if it exists, describes what resource the cue acts upon. (A target may be a file or
another cue.)

Target Number
The target number of a cue, if it exists, is the number of the targeted cue.

Pre Wait
The pre wait of a cue determines how long the playback of the cue sequence is blocked before the
cue is fired.

Action Duration
The action duration of a cue describes how long it takes for the cue to complete. Some cues are
instantaneous, and so do not display a duration.

Post Wait
The post wait of a cue determines how long the playback of the cue sequence is blocked after a cue
is fired.

Continue Mode
The continue mode of a cue determines if playback continues automatically after a cue is fired and
the post wait is complete. The continue mode is described in detail here.

Firing a cue generally causes four things to happen, in this order:
1. If a pre wait duration is specified for the cue, the pre wait is performed.
2. The action of the cue is begun. (e.g. sound begins to play, another cue is given the "start" command, etc.)
3. If a post wait duration is specified for the cue, the post wait is performed.
4. If the cue is set to auto-continue or auto-follow, the next cue in the sequence is fired. (i.e. QLab starts

again at step 1 for the next cue.)
Firing a running cue has no effect on the cue; it continues to run until it is stopped or completes running on its own.

Cue Subtopics:
• Audio Cues

◦ Audio Cue
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◦ Fade Cue
◦ Devamp Cue

• Video Cues
◦ Video Cue
◦ Camera Cue
◦ Animation Cue

• MIDI Cues
◦ MIDI Voice Message Cue (MIDI)
◦ MIDI Show Control Cue (MSC)
◦ MIDI File Cue
◦ MIDI SysEx Cue
◦ MIDI Timecode Cue (MTC)

• Control Cues
◦ Arm Cue
◦ Disarm Cue
◦ Goto Cue
◦ Group Cue
◦ Load Cue
◦ Memo Cue
◦ Pause Cue
◦ Reset Cue
◦ Script Cue
◦ Start Cue
◦ Stop Cue
◦ Target Cue
◦ Wait Cue
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Related Tutorial

Video tutorial 2-1: Audio Signal Flow

Audio Cue
Audio Cues play sound files, and thus accept sound files as their target.
Audio Cues are built on QuickTime, making them able to play all file
formats understood by QuickTime. These formats include WAVE, AIFF,
MP3, and others. More than one Audio Cue may use the same sound file
as a target. Note that compressed audio formats such as MP3 require more processing power to play than
uncompressed formats such as WAVE and AIFF. Therefore, when you need to play many sounds simultaneously you
will benefit from using uncompressed formats.

Audio Cues support up to 16 channels per file. (Some file formats, such as WAVE, can store more than two channels
of audio in a single file.)

Audio Cues support up to 48 output channels to the designated audio device.

Audio Cues buffer their audio data for increased performance and decreased latency during playback. When an
Audio Cue is loaded this buffer is filled.

Audio Cue Subtopics:
• Settings

◦ Output Patch
◦ Start and End Times
◦ Play Count and Looping
◦ Guaranteed Synchronization
◦ The Waveform Display
◦ Integrated Fade Envelope

• Volume Knobs and Sliders
• Levels
• Trim
• Tools

◦ Copy/Paste Levels
• Preferences

◦ Aggregate Devices
◦ Device Volume Levels and Routing

Settings

QLab Documentation Copyright ©2010 Figure 53, LLC Page 22 of 77

http://figure53.com/qlab/tutorials/2-1.php


Output Patch

The output patch determines which audio device is used by the Audio Cue. The mapping of output patch to audio
device is set in the Audio Cue preferences. The abstraction of the output patch makes it easy to build designs for
which the final audio devices are unknown, or to adjust a workspace to accomodate changes in the available audio
devices on the current system.

Start and End Times

You may trim the head and tail of your sound file with the start and end time parameters. These may also be set
visually with the waveform display.

Times may be reset to the natural beginning or end of the file with the arrow buttons next to the text fields.

When you assign a new file to the Audio Cue, the start and end times are reset to the natural beginning and end of
the file.

Play Count and Looping

The loop start and loop end times specify a portion of the file which you may choose to loop. These times may fall
anywhere between the overall start and end times.

By default, the looping section will play through only once. (In other words, the looping section does not loop.) If
you increase the play count to 2 or more the looped section will play the specified number of times.

The loop times may also be set visually with the waveform display.

Guaranteed Synchronization

All Audio Cues assigned to the same audio output device can be guaranteed to remain exactly synchronized. For
example, if you have four stereo sound files inside a Group Cue that is set to "Start all children simultaneously", all
eight channels of those files can be played back with sample-accurate synchronization.

QLab allows you to enable or disable synchronization of audio on a cue-by-cue basis. Guaranteeing synchronization
may require shaving a small amount of audio from the beginning of the cue. This will not normally be noticeable,
but can be noticed in the case where your audio file has a sharp attack at the very beginning of the file. When
synchronization is disabled, all audio data from the file will be guaranteed to play, but the audio will no longer by
guaranteed to stay synchronized with other cues.

The Waveform Display

The waveform display allows you to quickly and precisely adjust several parameters of your Audio Cue.

By default the waveform display will show the entire sound file. Use the zoom buttons or the scroll wheel of your
mouse to change the scale of the waveform display and zoom in or out.
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Dragging the start time bar to remove silence at the beginning of a file.

You may adjust the start and end times by dragging the white time bars left and right across the waveform. (The
bar is hidden if the start time is zero or the end time is the very end of the file.) If the cue is set to have any loops,
you may also adjust the loop start and loop end times in the same way. (The looped section is drawn in green and
outlined by a green rectangle.)

The yellow cursor displays the playback progress.

The yellow cursor displays the playback progress. Clicking once within the waveform will load the cue to that
position. You may also click and drag to select a region of the waveform.

Click and drag to select a region.

When a region is selected the cue will temporarily only play that region (and loop it indefinitely). When the
waveform view has focus the preview key will play and pause the cue. (The preview key is set in the workspace
preferences—it is 'V' by default.)

Use the quick-set buttons at the top left to set the start and end (or the loop start and loop end) of the cue from
the selected region.
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The looping portion has been set from the selected segment.

Integrated Fade Envelope

The integrated fade envelope allows you to make adjustments to the master volume of the cue in a timeline
fashion. The integrated fade envelope ranges from -60 dB to 0 dB. Activate it by toggling the fade envelope button
at the lower left.

You may customize the shape of the fade by clicking near the yellow fade curve to add a control point. Drag the
control points to achieve the desired shape.
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Volume Knobs and Sliders

To adjust a volume knob or slider, click on it and drag the mouse up or down. Option-clicking on a knob or slider
will alternately set the value to -INF dB (if not already -INF) or 0 dB.

The volume knobs and sliders are colored according to whether they are "live" or "dead". Saturated, opaque sliders
and knobs are live, while gray transparent ones are dead. This distinction indicates that not all channels will apply
to all output devices.

Each slider of an Audio Cue can be assigned a gang using the Gangs button. You assign any name as the gang of
each channel. All channels with the same name will be adjusted together when you drag the volume sliders.

You can set default Gangs for new cues in the Audio Cue preferences.

Levels

The Levels tab allows you to set the initial volume of the Audio Cue when it begins to play. These are the levels a
Fade Cue will adjust.

For example, consider fading a sound in from silence to full volume. You would first set the master level for the
Audio Cue to -infinite dB. This will cause the Audio Cue to be silent when it first begins to play. You would then
create a Fade Cue that adjusts the master level up to 0 dB. This would fade the sound to full volume.

If you have a Pro Audio License you can access up to 48 output channels with each Audio Cue.

When an audio cue is playing the current average power level and peak hold level are displayed inside the output
sliders.

A stereo audio file routed to a two channel output device.

QLab dynamically adjusts the layout of the levels tab depending on how much space is available.
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To conserve space the crosspoint knobs have been moved next to the output sliders.

Trim

The Trim tab allows you to adjust the final overall volume of each output channel. An example of their use would be
if you have a series of fades operating on a single Audio Cue: the series of fades may be just right except that you
want the entire sequence to be slightly louder. Instead of having to adjust each end volume of each fade
separately, you can simply go to the Trim tab and change the master volume up in one place.

The Trim can only be changed manually; they can not be changed by a Fade Cue.

If you have a Pro Audio License you can access up to 48 output channels for each Audio Cue.

Tools

Copy/Paste Levels

The Copy/Paste Levels tool is available from the Tools menu when an Audio Cue is selected. This tool can be used to
copy the entire Levels matrix to the clipboard (including master, inputs, outputs, crosspoints, and gangs). Levels
can then be pasted to anything that has audio levels, including Audio Cues, Fade Cues, and Video Cues.

Preferences

The Audio Cue preferences allow you to map output patches to output devices, set a maximum volume limit for all
audio, define where the volume will reach silence (i.e. what decibel level corresponds to -INF decibels), and set
default volume levels and gangs for new Audio Cues. If you have the Pro Audio License you can also edit the global
volume levels for audio devices.

To map a patch number to an audio device, click on the output patch you wish to map and drag the patch connector
to the desired audio device. Note that you may have more than one patch connected to the same device.

If you have a Pro Audio License you will see buttons that allow you to edit the settings of each audio device. Those
settings are described below.
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Audio Cue preferences.

Aggregate Devices

If you have a Pro Audio License you can assign Audio Cue patches to aggregate audio devices. Aggregate audio
devices may be created using Apple's Audio MIDI Setup utility. Note that aggregate audio devices can require
significantly more processing power to use than normal audio devices.
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Audio device editor.

Device Volume Levels and Routing

With a Pro Audio License you may adjust each audio device's master level matrix. These levels are global—the audio
from every Audio Cue assigned to this output device will be affected by these level adjustments.
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The crosspoints of the device matrix allow you to route Audio Cue output channels to different physical output
channels on the device.

At the bottom of the device editor is a popup button which allows you to assign levels to the device from any other
device this workspace has ever been connected to. This is especially useful when transferring the workspace to a
new machine, where it may be necessary to set the original levels from a previous device into the global matrix for
a new device.
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Related Tutorial

Video tutorial 2-1: Fade and Group Cues

Fade Cue
A Fade Cue is used to adjust the volume levels of another cue. Fade
Cues accept other cues as their target, which represent the cue that
will be faded when the Fade Cue is fired during playback. Only cues
that are "fadeable" can be set as a Fade Cue target. This currently
includes Audio Cues, Video Cues, and Group Cues.

Fade Cue Subtopics:
• Curve Shape & Settings

◦ Duration
◦ Stop Target when Done
◦ Fade Type
◦ Fade Curve

• Levels
• Tools

◦ Copy/Paste Levels
◦ Set Levels from Target
◦ Copy/Paste Fade Shape
◦ Live Fade Preview

Curve Shape & Settings

Duration

Set the length of a Fade Cue using the duration parameter.

Stop Target when Done

This checkbox allows you to specify that the target cue will be stopped when the fade is complete.

Fade Type

A Fade Cue may make an absolute or relative adjustment to the volume of a sound. These types have the following
characteristics:

An absolute fade adjusts the volume to a specific level. When an absolute fade begins, the current absolute volume
of the sound is checked and the Fade Cue computes a fade adjustment from that initial volume to the specified final
volume.
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Only one absolute fade may be applied to a particular channel of a sound at any one time. For example, if one Fade
Cue is performing an absolute fade on the second output channel of an Audio Cue and another Fade Cue begins
another absolute fade on the same channel, the second Fade Cue takes over as owner of the channel. (i.e.
Whichever started most recently is the one that has control.)

A relative fade adjusts the volume up or down relative to the current volume, whatever it may be. An unlimited
number of relative fades may be applied to a sound channel at any one time. A relative fade may also be applied to
Group Cues to adjust the volume of all sounds within the group.

The final volume of a channel is therefore determined by three things: the trim of the channel, the absolute fade
level, and zero or more relative fade levels. Note that if any one of those levels is silent, the final volume will be
silent. Thus, if a channel's initial level is set to negative infinite decibels, a relative fade would not be able to fade
the volume up.

A note on using fades: Volume levels are reset on a cue after it has been stopped and reloaded. A rule of thumb to
remember is: volumes are preserved the entire time there is a yellow dot or a green triangle next to the cue. As
soon as either of those disappears, the next time the cue fires it will have reset its volumes.

Fade Curve

The fade curve determines the manner in which the volume is adjusted over the course of the fade. You may
specify one shape for values that will fade up, and a different shape for values that will fade down. (This can be
necessary in some circumstances to achieve things like a "natural sounding" crossfade.)

You can add control points just by clicking on the fade curve GUI. Several key commands are also available when
the fade curve GUI has focus:

Delete Delete the selected control point.

← Select the previous control point.

→ Select the next control point.

Shift-← Nudge the selected control point to the left.

Shift-→ Nudge the selected control point to the right.

↑ Nudge the selected control point up.

↓ Nudge the selected control point down.

Levels

The "Levels" tab allows you to specify which channels you want to fade, and what their final volume will be. You can
specify a separate final volume for each channel.

Only "live" sliders and knobs will actually be applied to the target cue. This allows you to choose which channels of
the sound you want to fade. You can make a slider or a knob live or dead by clicking on it. It will turn opaque and
saturated when it is live, and gray and translucent when it is dead. Changing the volume of any slider or knob will
automatically make it live.
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The volume of a fade cue is specified in decibels. The range of the end volume for an absolute fade is +12 dB to -
infinite dB (roughly 4x volume to silence). The range of the end volume for a relative fade is +120 dB to -infinite
dB.

Click the "Gangs" button to assign gangs to the master channel and each output channel. Each channel in the same
gang will be adjusted together when you change the volume of one member of the gang.

The levels tab will only display as many input channels as exist in the target cue.

The picture below shows a Fade Cue that will change only the master volume of its target (fading it to 0 dB—full
volume).

Fade the master channel of an Audio Cue to 0 dB.

Tools

Copy/Paste Levels

If you have a Pro Audio License you can copy and paste levels to and from other cues. Use the key shortcut "Shift-
Command-C" and "Shift-Command-V", found under the "Tools" menu.

Set Levels from Target

If you have a Pro Audio License, you can set the levels of the Fade Cue to those used by the target of the cue. This
allows you to easily use the "starting position" of a target Audio Cue. You can set levels from the target with the key
shortcut "Shift-Command-T", found under the "Tools" menu.

Copy/Paste Fade Shape

If you have a license you can copy and paste the fade shape to and from other cues.
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Live Preview

If you have a Pro Audio License you can activate live previews for Fade Cues. This will cause the volume of the
target cue to change in real time as you adjust the levels for the cue. You can toggle live preview mode with the
key shortcut "Shift-Command-L", found under the "Tools" menu.
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Devamp Cue
A Devamp Cue accepts Audio Cues as its target. When the Devamp cue is fired it turns off the looping of the target
Audio Cue. The next time the target Audio Cue reaches the end of it's looped section it will not loop again but will
instead play on through to the end of the file.

Devamp Cue Subtopics:
• Settings

◦ Fire next cue when target's loop ends
◦ Stop target when loop ends

Settings

Fire next cue when target's loop ends

This option will cause the next cue in the list to be fired at the exact moment that the loop in the target cue
devamps.

One use of this option is to "stitch together" multiple Audio Cues, by having the next Audio Cue start at the precise
moment the previous Audio Cue finishes its loop.

Stop target when loop ends

You may also choose to stop the target at the exact moment the loop ends. Again, this is useful when stitching
together multiple Audio Cues.
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Video Cue
Video Cues allow you to display movies and still images on any screen attached to your computer. Video Cues are
built on Quicktime, allowing them to use any media supported by Quicktime. This includes MOV, AVI, MPEG, JPG,
PNG, etc.

A Pro Video license is required to reactivate Video Cues that have been saved to disk. In addition, the Video Cue
requires a graphics card that supports Quartz Extreme and Core Image. Please note: a compatible video card is a
minimum requirement—not a guarantee of a specific performance level. QLab provides a wide range of video
functionality, some of which demands a lot of processing power. Please see the section Performance Tips to learn
more about obtaining the best video performance.

Video Cue Subtopics:
• Setting a Background
• Hiding the Cursor
• Performance Tips
• Important Note Regarding Still Images
• Settings

◦ Audio Patch
◦ Opacity
◦ Layer
◦ Start and End Times
◦ Looping
◦ Auto-stop at End
◦ Screens
◦ Full Screen Mode
◦ Custom Geometry Mode
◦ The Stage

• Audio Levels
• Audio Trim
• Composer
• Preferences

Setting a Background

All screens showing a Video Cue will be covered with a black background while the cues are playing on those
screens. Screens where no video is playing show the normal desktop. As soon as all cues are stopped for a
particular screen the desktop background will again show on that screen. Therefore if you wish the background to
remain black for a screen you must make sure that at least one cue is running on that screen. It is advisable to set
the Desktop background to a pure black image, just in case all cues are stopped unexpectedly.

If you wish to set a non-black background color simply create a Video Cue that uses a still image file for the custom
background.

Hiding the Cursor

The mouse cursor will automatically be hidden if all screens are playing video. If one or more screens are showing
the desktop the mouse will remain visible.

Performance Tips

Obtaining the best video performance is a matter of balancing three principle factors:
1. Hard drive speed / using multiple hard drives. A faster hard drive can supply raw video data more

quickly. If you are using uncompressed video formats this can be especially important.
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2. CPU speed. The CPU decodes media data and performs other ancillary processing.
3. Graphics card (GPU) speed. The graphics card performs all image processing of the video data in real

time.
All three of these factors play a critical role during video playback, and your system performance can only be as
strong as the weakest link in this list. Focusing on just one factor (e.g. focusing solely on the CPU) will not
necessarily improve performance if the other factors are not also considered.

QLab performs all video operations on your graphics card, not your CPU. Live composition and fading of videos, the
use of Core Image filters, and other such real-time processing all takes place on the GPU. In general, the fewer
pixels the graphics card must process the smoother playback will be. Thus, if one card is having trouble driving two
separate displays, try having it drive only one display. If the display resolution is high, try reducing the resolution.
Fewer pixels means less work for your graphics card.

Each Video Cue achieves optimal performance if it is assigned to only a single screen. When assigned to
only one screen, the video will be rendered directly to the video RAM (VRAM) for that screen. If a Video Cue is
rendering across multiple screens it must first render the video to system RAM and then copy frames from RAM to
VRAM in each separate graphics card. This extra copy operation is more expensive and increases CPU load.

More discussion of video performance can be found on our blog:

http://figure53.com/blog/2010/11/18/the-magic-bullet-part-i-the-hardware/

Important Note Regarding Still Images

Video cues that display still images will remain running until explicitly stopped. Even if they are no longer
visible (for example, if another still image is covering them), they are loaded and consuming resources. It is
important to stop old still image video cues that you do not need anymore, so that their resources can be released.

Settings

A Video Cue in full screen mode.

Audio Patch

The Audio Patch of Video Cues functions the same way as the Patch of Audio Cues. It is used to assign the audio
output device for the cue. Video Cues use the same patch routings as Audio Cues—the ones in the Audio Cue
preferences.
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Opacity

The opacity specifies the initial visibility of the cue. For example, if you wish to fade in the cue you would set it to
0% so it would start out invisible. Then you would use an Animation Cue to fade it in to 100% opacity.

Layer

The order in which video frames are drawn is specified by the layer. A Video Cue with a higher numbered layer will
be drawn over Video Cues with a lower numbered layer. You can use this, for example, to keep a mask image
displayed over a series of other Video Cues.

Entering "top" means the Video Cue will be displayed over all other previously fired cues. The most recent Video
Cue in the "top" layer is always displayed on top.

Start and End Times

You can trim the head and tail of the video file with the start and end times. The reset buttons next to the text
fields will reset the times to the natural start time (0) and the natural end time (the end of the file).

Looping

Use the looping checkbox to tell the Video Cue to play in an infinite loop.

Auto-stop at End

By default, Video Cues will automatically stop themselves when they finish playing. If you want the last frame of the
video to remain displayed when the video is complete, uncheck this box.

This setting does not apply to still images. Still images will always remain displayed until they are explicitly stopped
by another cue.

Screens

The screens buttons allow you to select which screens your Video Cue will use. Note that the screen numbers are
like audio patches: the actual map from number to physical device is set in the workspace preferences. So "Screen
1" can be any device connected to your computer, or no device at all. The actual device is set by how you have
mapped "Screen 1" to a physical screen in the workspace preferences.

The tooltip for each screen button will show the name of the actual physical screen currently assigned to that
number. Hold your mouse over the button for a moment to see the tooltip.

As noted in the performance tips above, your Video Cue will perform optimally when it is assigned to only one
screen.

Full Screen Mode

When a Video Cue is in full screen mode it will be displayed on all the selected screens. You may optionally preserve
the aspect ratio or stretch the video to completely fill the screens.
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Custom Geometry Mode

A Video Cue in custom geometry mode.

When a Video Cue is in custom geometry mode you can customize the translation, scale, and rotation of the video.

You can use the stage interface to modify these parameters visually. Click anywhere on the stage and drag to
adjust the translation. Click in the rotation bar handle and drag to adjust the rotation. Use the scroll wheel on the
mouse to adjust the scale.

By default the X and Y scaled are locked to the same value. Click the lock button to toggle this setting on and off.

If you enter a negative value for the scale, QLab will flip the video image along that axis.

The Stage

QLab 2 introduces a concept called the video stage. Instead of positioning your videos directly on the screens, you
position them on the video stage. This allows you to more easily move a video workspace to a new computer with
different screens.

The video stage GUI displays all the screens currently attached to your system. The screens selected for this cue
are outlined in yellow. The video cue itself is displayed as a translucent yellow rectangle with a yellow border.

The light white crosshairs indicate the global origin of the stage. This origin is set in the Video Cue preferences. This
origin is useful if, for example, you want to display all your videos centered on a different screen. Instead of moving
individual cue to the new screen you can just change the origin of the stage.

Click anywhere on the stage and drag to adjust the translation. Click in the rotation bar handle and drag to adjust
the rotation. Use the scroll wheel on the mouse to adjust the scale.

Audio Levels

QLab allows you to route the audio in your video files exactly like the Levels of an Audio Cue. This audio is also in
sample accurate sync, just like Audio Cues.
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Audio Trim

Just as with Audio Cues, the Trim tab allows you to adjust the final overall volume of each output channel. An
example of their use would be if you have a series of fades operating on a single Video Cue: the series of fades may
be just right except that you want the entire sequence to be slightly louder. Instead of having to adjust each end
volume of each fade separately, you can simply go to the Trim tab and change the master volume up in one place.

The Trim can only be changed manually; they can not be changed by a Fade Cue.

Composer

QLab provides flexibility by allowing you to use a custom Quartz Composer file to render the video. By creating your
own compositions, you can apply Core Image filters, render your video in 3D, and apply even more complex
animations.

QLab will provide your Quartz Composition frames from the video file as it plays. To receive the frames your
composition must publish an "Image" input port. Other ports you may publish include "xPosition", "yPosition",
"Width", "Height", "Rotation", and "Opacity". (Opacity is passed as a color.)

To learn how to use Quartz Composer with QLab, try downloading this example Quartz Composer file. It will work
with QLab "out of the box", and you can modify it however you like.
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Preferences

The preferences panel for Video Cues allows you to map screen numbers to physical display devices. To map a
screen number to a physical device, click on the number you wish to map and drag the patch connector to the
desired display device. You may have more than one screen number assigned to the same display device.

The Video Cue preferences also specify the global origin for the video stage. You may click and drag on the stage
GUI to adjust the origin, or command-click to automatically center the origin on the clicked screen.
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Camera Cue
QLab 2 supports live video feeds directly in your workspace using any FireWire camera. Camera Cues operate just
like Video Cues, except they have no audio.

By default a Camera Cue will run until it is stopped. If you enter a non-zero action time for the cue, it will run for
the duration you specify.

Please note that display latency can vary dramatically depending on the video camera you use. QLab displays each
frame as soon as it is received, so you may need to experiment with different cameras to find a device which meets
your latency requirements.

Camera Cue Subtopics:
• Settings

◦ Camera
◦ Opacity
◦ Layer
◦ Screens
◦ Full Screen Mode
◦ Custom Geometry Mode
◦ The Stage

• Composer
• Preferences

Settings

A Camera Cue in full screen mode.

Camera

Use the Camera patch to pick which input device will be used for the Camera Cue. Camera numbers are assigned to
physical cameras in the workspace preferences.

Opacity

The opacity specifies the initial visibility of the cue. For example, if you wish to fade in the cue you would set it to
0% so it would start out invisible. Then you would use an Animation Cue to fade it in to 100% opacity.
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Layer

The order in which video frames are drawn is specified by the layer. A Camera Cue with a higher numbered layer
will be drawn over cues with a lower numbered layer.

Entering "top" means the Camera Cue will be displayed over all other previously fired cues. The most recent cue in
the "top" layer is always displayed on top.

Screens

The screens buttons allow you to select which screens your Camera Cue will use. Note that the screen numbers are
like Camera patches: the actual map from number to physical device is set in the workspace preferences. So
"Screen 1" can be any device connected to your computer, or no device at all. The actual device is set by how you
have mapped "Screen 1" to a physical screen in the workspace preferences.

The tooltip for each screen button will show the name of the actual physical screen currently assigned to that
number. Hold your mouse over the button for a moment to see the tooltip.

As noted in the Video Cue performance tips above, your Camera Cue will perform optimally when it is assigned to
only one screen.

Full Screen Mode

When a Camera Cue is in full screen mode it will be displayed on all the selected screens. You may optionally
preserve the aspect ratio or stretch the camera image to completely fill the screens.

Custom Geometry Mode

A Camera Cue in custom geometry mode.

When a Camera Cue is in custom geometry mode you can customize the translation, scale, and rotation of the
camera feed.

You can use the stage interface to modify these parameters visually. Click anywhere on the stage and drag to
adjust the translation. Click in the rotation bar handle and drag to adjust the rotation. Use the scroll wheel on the
mouse to adjust the scale.

By default the X and Y scaled are locked to the same value. Click the lock button to toggle this setting on and off.
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If you enter a negative value for the scale, QLab will flip the camera image along that axis.

The Stage

QLab 2 introduces a concept called the video stage. Instead of positioning your videos directly on the screens, you
position them on the video stage. This allows you to more easily move a video workspace to a new computer with
different screens.

The video stage GUI displays all the screens currently attached to your system. The screens selected for this cue
are outlined in yellow. The camera cue itself is displayed as a translucent yellow rectangle with yellow borders.

The light white crosshairs indicate the global origin of the stage. This origin is set in the Video Cue preferences. This
origin is used if, for example, you want to display all your videos centered on a different screen. Instead of moving
individual cue to the new screen you can just change the origin of the stage.

Click anywhere on the stage and drag to adjust the translation. Click in the rotation bar handle and drag to adjust
the rotation. Use the scroll wheel on the mouse to adjust the scale.

Composer

QLab provides flexibility by allowing you to use a custom Quartz Composer file to render the camera feed. By
creating your own compositions, you can apply Core Image filters, render your feed in 3D, and apply even more
complex animations.

QLab will provide your Quartz Composition frames from the camera feed as it runs. To receive the frames your
composition must publish an "Image" input port. Other ports you may publish include "xPosition", "yPosition",
"Width", "Height", "Rotation", and "Opacity". (Opacity is passed as a color.)

To learn how to use Quartz Composer with QLab, try downloading this example Quartz Composer file. It will work
with QLab "out of the box", and you can modify it however you like.
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Preferences

The preferences panel for Camera Cues allows you to map camera numbers to physical camera. To map a camera
number to a physical camera, click on the number you wish to map and drag the patch connector to the desired
display device. You may have more than one camera number assigned to the same camera.

The screen numbers and global origin used by the Camera Cue are specified in the Video Cue preferences.
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Animation Cue
The Animation Cue allows you to animate your Video Cues and Camera Cues in real time.

Animation Cue Subtopics:
• Settings

◦ Duration
◦ Opacity, Translation, Scale, and Rotation
◦ Stop Target when Done
◦ Interpolation Curve
◦ The Stage

Settings

Duration

Specify the duration of the animation with this parameter. It is sometimes useful to use a duration of zero for
instantaneous adjustments.

Opacity, Translation, Scale, and Rotation

You may animate one or more of these properties of the target cue. Toggle the checkboxes to specify which of the
properties you wish to animate. When an Animation Cue starts running it queries the target cue for the current
value of each property it will animate. It then animates from that current value to the final value you specify here.

For Video Cues and Camera Cues in full screen mode, only opacity, scale, and rotation properties may be animated.

Stop Target when Done

When the Animation Cue has finished running you can optionally specify that it will stop its target cue.

Interpolation Curve

The interpolation curve allows you to customize the shape of the animation. This curve is applied to all the animated
properties.
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The Stage

As with the Video Cue and the Camera Cue, the stage interface displays all the screens currently attached to your
system. The frame of the target cue is displayed as a translucent yellow rectangle on the video stage.

You can click anywhere on the stage and drag to adjust the translation. Click in the rotation bar handle and drag to
adjust the rotation. Use the scroll wheel on the mouse to adjust the scale.

The light white crosshairs indicate the global origin of the stage. This origin is set in the Video Cue preferences. This
origin is used if, for example, you want to display all your videos centered on a different screen. Instead of moving
individual cue to the new screen you can just change the origin of the stage.
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MIDI Cue
The MIDI Voice Cue (MIDI) allows you to send all MIDI voice messages.

A Pro MIDI license is required to reactivate MIDI cues that have been saved to disk.

MIDI Cue Subtopics:
• MIDI Message

◦ Output Patch
◦ Command, Channel, and Parameters
◦ Integrated Fade

• Preferences

MIDI Message

Output Patch

The output patch determines which output device is used by the MIDI Cue. The mapping of output patch to output
device can be set in the workspace preferences. The output patch makes it easy to build designs for which the final
MIDI devices are unknown, or to adjust a workspace to accomodate changes in the available MIDI devices on the
current system.

Command, Channel, and Parameters

Use the command pop-up menu to select what kind of command this MIDI Cue will send. The commands include:
• Note On
• Note Off
• Program Change
• Control Change
• Key Pressure (Aftertouch)
• Channel Pressure
• Pitch Bend Change

Use the channel field to select the MIDI channel for this command. The MIDI channel is a number from 1 to 16.

Depending on what kind of MIDI command you are sending, different MIDI parameters will appear. Use these fields
to specify the parameters of the command. QLab will limit you to valid ranges for each field.
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Integrated Fade

QLab supports fading over a range of output values for some MIDI commands. These commands include:
• Control Change
• Key Pressure (Aftertouch)
• Channel Pressure
• Pitch Bend Change

To fade any of these commands, select the fade checkbox and specify the final value for the command's fadeable
parameter. Enter a duration and define the shape of the fade to complete the settings.

Preferences

The preferences panel for MIDI Cues allows you to map output patches to MIDI output devices. To map a patch to a
device, click on the output patch you wish to map and drag the patch connector to the desired output device. Up to
12 MIDI devices may be mapped in the workspace.

Note that you may have more than one patch connect to the same output device.
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MIDI Show Control (MSC) Cue
The MIDI Show Control Cue allows you to send most MIDI show control commands (all commands except the two-
phase commit commands).

A Pro MIDI license is required to reactivate MSC cues that have been saved to disk.

MSC Cue Subtopics:
• MIDI Show Control Message

◦ Output Patch
◦ Command Format, Command, and Device ID
◦ Q Number, Q List, and Q Path
◦ Time

• Preferences

MIDI Show Control Message

Output Patch

The output patch determines which output device is used by the MSC Cue. The mapping of output patch to output
device can be set in the workspace preferences. The abstraction of the output patch makes it easy to build designs
for which the final MIDI devices are unknown, or to adjust a workspace to accomodate changes in the available
MIDI devices on the current system.

Command Format, Command, and Device ID

Use the command format pop-up menu to select what kind of command format this MSC Cue will use.

Use the command pop-up menu to select what kind of command this MSC Cue will send. The available commands
include:

• GO
• STOP
• RESUME
• TIMED_GO
• LOAD
• SET
• FIRE
• ALL_OFF
• RESTORE
• RESET
• GO_OFF

• STANDBY_+
• STANDBY_-
• SEQUENCE_+
• SEQUENCE_-
• START_CLOCK
• STOP_CLOCK
• ZERO_CLOCK
• SET_CLOCK
• MTC_CHASE_ON
• MTC_CHASE_OFF
• OPEN_CUE_LIST
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• GO/JAM_CLOCK • CLOSE_CUE_LIST
• OPEN_CUE_PATH
• CLOSE_CUE_PATH

Use the device ID field to specify which device will receive this MSC command. The device ID can be a number from
0 to 127.

Q Number, Q List, and Q Path

Many MIDI show control messages accept parameters for a Q Number, Q List, and Q Path. Each of these must be
composed of only numbers and periods. In addition, you may not enter a Q List until a Q Number has been
specified, or a Q Path until a Q List has been specified. The actual meaning of these parameters is determined by
the device that receives them.

Time

MSC Cues support all four timecode formats. QLab will also convert between formats when the format is changed.

Preferences

The MSC Cue preferences allow you to map output patches to MIDI devices. Up to 12 separate MIDI devices may be
assigned.

To map a patch to a device, click on the output patch you wish to map and drag the patch connector to the desired
output device.

You may have more than one patch connect to the same output device.
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MIDI File Cue
The MIDI File Cue allows you to play standard MIDI files to any MIDI destination on your system. Type 0 and Type
1 MIDI files are both supported.

A Pro MIDI license is required to reactivate MIDI File cues that have been saved to disk.

MTC Subtopics:
• Settings

◦ Output Patch
◦ Playback Rate

Settings

Output Patch

The output patch determines which output device is used by the MIDI File Cue. The mapping of output patch to
output device can be set in the workspace preferences. The output patch makes it easy to build designs for which
the final MIDI devices are unknown, or to adjust a workspace to accomodate changes in the available MIDI devices
on the current system.

Playback Rate

The playback rate determines how fast or slow the MIDI file will be sent to the MIDI destination. A value of 1 will
send the MIDI file at the default rate specified in the file, a value of 2 will send the MIDI messages at twice the
default rate specified in the file, etc.

QLab Documentation Copyright ©2010 Figure 53, LLC Page 52 of 77



MIDI SysEx Cue
The MIDI SysEx Cue allows you to send all MIDI SysEx messages.

A Pro MIDI license is required to reactivate MIDI SysEx cues that have been saved to disk.

MIDI SysEx Subtopics:
• Settings

◦ Output Patch
◦ Raw SysEx Message

• Preferences

Settings

Output Patch

The output patch determines which output device is used by the MIDI SysEx Cue. The mapping of output patch to
output device can be set in the workspace preferences. The abstraction of the output patch makes it easy to build
designs for which the final MIDI devices are unknown, or to adjust a workspace to accomodate changes in the
available MIDI devices on the current system.

Raw SysEx Message

Send any SysEx message by entering a raw SysEx message into the text box. Use hexadecimal characters and
white space only. If you use invalid characters the cue will be broken and refuse to fire.

NOTE: Do NOT include the starting F0 and ending F7 required for all SysEx messages; QLab adds these values for
you.

Preferences

The MIDI SysEx Cue preferences allow you to map output patches to MIDI devices. Up to 12 separate MIDI devices
may be assigned.

To map a patch to a device, click on the output patch you wish to map and drag the patch connector to the desired
output device.

You may have more than one patch connect to the same output device.
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MTC Cue
The MTC Cue allows you to generate midi timecode and send it to any MIDI device. If you pause MTC cues, the
outgoing timecode will also be paused. If you then restart the cue, it will restart where it left off.

A Pro MIDI license is required to reactivate MTC cues that have been saved to disk.

MTC Subtopics:
• Settings

◦ MIDI Destination
◦ SMPTE Format
◦ Start Time

Settings

MIDI Destination

Directly select the MIDI device destination that will receive the timecode from the popup menu. (A MIDI patch is not
used for MTC Cues.)

SMPTE Format

The MTC Cue will generate timecode in all four MTC formats:
• 24 fps
• 25 fps
• 30 fps drop
• 30 fps non-drop

Start Time

By default timecode will start counting from time zero. However, you can also start at any other time by entering
your desired time in the Start Time field.
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Arm Cue
The Arm Cue simply arms its target cue.

When a cue is armed it will perform its action when fired. When a cue is disarmed it will still perform its pre wait
and post wait and auto-continue or auto-follow, but will not perform its action.

QLab Documentation Copyright ©2010 Figure 53, LLC Page 55 of 77



Disarm Cue
The Disarm Cue simply disarms its target cue.

When a cue is disarmed it will still perform its pre wait and post wait and auto-continue or auto-follow, but will not
perform its action. When a cue is armed it will perform its action when fired.
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Goto Cue
A Goto Cue is used to direct the playback order of a cue sequence. Goto Cues accept other cues as their target. This
target is the cue that will follow the Goto during playback.

An important thing to understand about the Goto Cue is that it is not the same thing as a "set the playback position
here" function. Instead, if you think of the cues as dominoes, the Goto Cue lets you direct where the dominoes will
fall as they knock in to each other.

The Goto Cue can be particularly useful in conjunction with the Target Cue. A Target Cue can change where the
Goto Cue will go.
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Group Cue
The Group Cue is an important and subtle feature of QLab. Group Cues do nothing but contain other cues, including
other Group Cues. A Group Cue allows you to build composite cues of many other cues. This allows you to collect
related cues together, and to hide the details of a complex cue sequence within a single top-level cue in your
workspace. Some cues also allow you to perform operations on an entire group of cues at one time. Fade Cues, for
example, allow you to adjust the volume of every Audio Cue in a group. While Group Cues are just containers of
other cues, there are several different ways they can respond when fired. These are discussed below.

Group Cue Subtopics:
• Mode
• Preferences

Mode

The Group Cue has four modes:

Mode Description

Fire first child
and enter into
group

In this mode, firing the group will start the first cue inside the group
and the playback position will descend into the group.

Fire first child
and go to next
cue

In this mode, firing the group will start the first cue inside the group,
but the playback position will continue to the next cue after the
group.

Fire all children
simultaneously

In this mode, firing the group will start all of the cues inside the
group at the same time. The playback position will continue to the
next cue after the group.

Fire random
child and go to
next cue

In this mode, firing the group will start a random cue inside the
group. The playback position will continue to the next cue after the
group.

Stopping a Group Cue always stops all the cues in the group.

Preferences

The Group Cue preferences allow you to specify the default mode for new Group Cues.
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Load Cue
The Load Cue can be used to explicitly preload a cue sequence to a specific time.

Load Time

The load time determines at what position the target sequence will be loaded. For example, a load time of zero will
load the target sequence at the very beginning of its timeline. A load time of thirty seconds will load the target
sequence thirty seconds into its timeline. You can therefore use the load cue to programmatically place cue
sequences on deck at arbitrary positions.
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Memo Cue
The Memo Cue does nothing. You can use it to insert notes into your cue list.
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Pause Cue
A Pause Cue is used to pause other cues. The cues may be resumed using the Start Cue.

Pausing a cue list will pause all cues in the list. Pausing a Group Cue will pause all cues in the group. The cues will
all remain sample-accurate synced.

As a rough guide you can think of the control cues arranged by the degree to which they change a cue's state:
• Reset : Absolutely everything gets set to original state.
• Stop : A running cue is halted, but in special cases some state may be retained.
• Pause : A running cue is halted, and all internal state is retained, ready to be restarted at the place it left

off.
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Reset Cue
The Reset Cue "resets and rewinds" everything about a cue to its initial state.

Examples:
• Resetting a cue list will put its playback position back to the top of the list.
• Resetting a Goto Cue will reset its target if it has been changed by a Target Cue.

For other cues, a reset is equivalent to a stop.

As a rough guide you can think of the control cues arranged by the degree to which they change a cue's state:
• Reset : Absolutely everything gets set to original state.
• Stop : A running cue is halted, but in special cases some state may be retained.
• Pause : A running cue is halted, and all internal state is retained, ready to be restarted at the place it left

off.
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Script Cue
The Script Cue allows you to run any AppleScript in a cue.

Note that AppleScripts can only be safely run on the main thread, so QLab must pause to completely run the script
before it can continue processing anything in the main thread. This means that if your script takes a long time,
QLab will not redraw the workspace or perform other updates on the main thread until the script is complete.

You'll find a handy list of QLab scripts and macros on the Figure 53 wiki: http://wiki.figure53.com/
QLab+Scripts+and+Macros

A Pro Audio, Pro Video, or Pro MIDI license is required to reactivate Script cues that have been saved to disk.

Script Cue Subtopics:
• AppleScript

AppleScript

You can enter any AppleScript into the text field of the AppleScript panel. If QLab is able to successfully compile the
script the text will be displayed with colored script syntax, and the script status will display "Successfully compiled".
If QLab is not able to compile the script, the script will appear in all-black font, and the error will appear in the
script status field.

QLab Documentation Copyright ©2010 Figure 53, LLC Page 63 of 77

http://wiki.figure53.com/QLab+Scripts+and+Macros
http://wiki.figure53.com/QLab+Scripts+and+Macros


Start Cue
A Start Cue is used to start other cues. Start Cues accept other cues as their target, which represent the cue that
will be triggered when the Start Cue is fired during playback.

Just as starting a cue with the GO button is like tipping over a series of dominoes (all the cues connected by auto-
continue or auto-follow), starting a cue with the Start Cue also tips the dominoes.
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Stop Cue
A Stop Cue is used to stop other cues. Stop Cues accept other cues as their target, which represent the cue that will
be stopped when the Stop Cue is fired during playback.

Stopping a cue list will stop all cues in the list. Stopping a Group Cue will stop all cues in the group.
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Target Cue
The Target Cue can be used to assign a new target to Goto Cues.

Target Subtopics:
• Cue Number

Cue Number

The "number of cue to assign" identifies which cue in the workspace will be the new target of the Goto Cue.

When a Target Cue is fired the newly assigned target will show up in the workspace in blue. This indicates that this
is a temporary target. When the cue with the temporary target is reset, it will regain its original target.
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Wait Cue
You may insert precise delays between cues using the Wait Cue.

Note that every cue includes an integrated wait which can be set before the cue activates (the "pre wait"), after the
cue activates (the "post wait"), or both. Using a Wait Cue instead of the integrated pre wait and post wait is mostly
a matter of personal preference.
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Preferences
QLab 2 provides both Application Preferences and Workspace Preferences. The settings in these preferences
are identical. The distinction is that the Application Preferences are used to initialize new Workspaces.

Once you have created a new workspace the settings stick with that workspace. So, for example, the Audio Device
patching and routing will stay with the workspace, not with the computer.

Preferences Subtopics:
• General
• Key Map
• Remote Control

General

The Display Mode specified the visual appearance of the cues list: you can make the rows small, medium, or large
and optionally use a dark bacgkround.

Double GO Protection determines how much time must pass between subsequent GO commands.

The general preferences also allow you to specify the behavior of the playback position. By default, the playback
position is always the same as the selected cue. If you disable this setting you can select cues (e.g. to edit them)
without changing the playback position of the cue list. When the playback position it independent of the selection
you can change the playback position in two ways:

1. Clicking in the status column of the cue you wish to make the playback position.
2. Pressing the "Load" key when the cue is selected (by default the load key is "L").
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Key Map

To change the global QLab hot keys click on the text field for the hot key you wish to change and press the key you
wish to use for that command. You can remove the hot key entirely by pressing the "X" button next to the text
field.
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Remote Control

If you have a Pro MIDI license you can control QLab remotely with MIDI Show Control commands or MIDI Voice
Message commands.

MIDI Show Control

QLab responds to the following MSC command formats:

• 0x7F - all types
• 0x01 - Lighting (General)
• 0x10 - Sound (General)
• 0x17 - Audio Effects Devices
• 0x30 - Video (General)
• 0x40 - Projection (General)
• 0x43 - Video Projectors

QLab responds to MIDI Show Control commands as follows:
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MSC
Command

QLab behavior

GO If no cue number is supplied, trigger the current cue list. If a cue
number is supplied, trigger the specified cue.

STOP If no cue number is supplied, pause all running cues. If a cue number
is supplied, pause the specified cue.

RESUME If no cue number is supplied, play all paused cues. If a cue number is
supplied, unpause the specified cue.

LOAD If no cue number is supplied, load the current cue. If a cue number is
supplied, load the specified cue.

ALL_OFF Stop all cues; does not change the playback position. (Equivalent to
pressing Escape or the "Stop All" toolbar button.)

RESET Stop and reset all cues. (Equivalent to pressing the "Reset All"
toolbar button.)

STANDBY_+ Select the next cue in the currently visible cue list.

STANDBY_- Select the previous cue in the currently visible cue list.

SEQUENCE_+ Move the playback position to the top of the next sequence and load
it. If a Q_list number is supplied, perform this action on the specified
cue list. Otherwise do it on the currently selected cue list.

SEQUENCE_- Move the playback position to the top of the previous sequence and
load it. If a Q_list number is supplied, perform this action on the
specified cue list. Otherwise do it on the currently selected cue list.

MIDI Voice Message Control

The "Use MIDI Controls" checkbox shows whether QLab is listening for MIDI Voice Messages to activate the QLab
commands shown in the panel. Note: MIDI Triggers assigned to individual cues are not affected by this checkbox.

Use the "Listen on Channel" parameter to specify which MIDI Voice channel QLab will use. Note: This channel will
be used for both QLab commands and MIDI Triggers assigned to individual cues.

You can use the "Capture" buttons to easily assign a MIDI Voice Message to a QLab command. The first MIDI Voice
Message received after pressing the capture button will be assigned to the selected command.

QLab commands can also be told to respond to MIDI messages with any velocity or control value instead of a
specific value. Simply enter the word "any" into the second text field and the command will be triggered for any
value.
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You can use the "Capture" button to assign the next incoming MIDI message to the highlighted command.
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Scripting
QLab 2 offers comprehensive scripting hooks to control the application programmatically. You can use AppleScript,
or through the OS X scripting bridge, languages like Python and Ruby.

You can explore the available scripting hooks from applications such as Apple's Script Editor. The scripting hooks
are self-documented in the scripting definitions file inside the QLab application. Viewing the scripting library will
display the full documentation for the scripting hooks.

You'll find a handy list of QLab scripts and macros on the Figure 53 wiki: http://wiki.figure53.com/
QLab+Scripts+and+Macros

The QLab scripting library as viewed with Script Editor.
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Example

Here is a simple AppleScript which demonstrates some of the controls you have over QLab through the scripting
hooks:

tell application "QLab"

tell workspace 1

make type "midi"

set myMIDICue to a reference to cue "1"

tell myMIDICue

set patch to 2

set channel to 1

set command to channel_pressure

set byte one to 100

set fade to enabled

set end value to 0

set duration to 7.4

end tell

set mainCueList to a reference to cue list 1

set playback position of mainCueList to myMIDICue

end tell

go workspace 1

end tell
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Licenses and Authorizations
The free version of QLab is a powerful audio playback environment and available at no cost. If you require advanced
functionality licenses are available to unlock additional features.

Three basic licenses are available: Pro Audio, Pro Video, and Pro MIDI. In addition, the Pro Bundle license
unlocks all features available from the three basic licenses.

Standard (non-expiring) QLab licenses must be both installed and authorized on your computer. Rental licenses
need only to be installed; there is no authorization process for a rental license.

You may transfer a standard license from one computer to another by deauthorizing the first computer, and then
installing and authorizing the license on the second computer.

These steps are described in detail below.

How to install a QLab License

When you purchase a QLab license, a license file is sent to the email address you provide during checkout. This
license file (which has the file extension "QLab2License" or "QLab2LicenseXML") can be installed by double clicking
on the file or dragging the file onto the QLab application icon.

How to authorize your QLab computer

Once your standard, non-expiring QLab license is installed you must authorize the computer to use that license.
(Rental licenses do not need to be authorized.)

IMPORTANT: You have a grace period between when you install a QLab license and when you must authorize the
computer. The features unlocked by your license will be fully functional during this grace period. However, the
functionality is not permanently unlocked until you authorize the computer. If the grace period expires
before you authorize the computer QLab will revert to the unlicensed state until it is authorized.

Online authorization

If your computer is connected to the Internet simply go to "QLab" → "Manage Licenses..." and click the "Authorize
this License" button for the license you wish to authorize. Your computer is now fully unlocked and authorized for
this license.

Offline authorization

If you use a computer that can not connect to the Internet you can still authorize it to use your QLab license.

Go to "QLab" → "Manage Licenses..." and click the "Export Offline Authorization Request..." button for the license
you wish to authorize. QLab will prompt you for a location to save the offline Authorization Request.

The offline Authorization Request is a simple HTML file you can open with any browser. It contains instructions on
how to use the request. Simply take this file to a network-connected computer and click on the link to download the
authorization file for your offline computer. The authorization file will have the file extension "QLab2Authorization".
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Transfer this file back to your offline computer and click the "Import Offline Authorization..." button to authorize this
license.

How to deauthorize your QLab computer

You must be connected to the Internet to deauthorize a license on your QLab computer. Go to "QLab" → "Manage
Licenses..." and press the "Deauthorize and Delete this License" button for the license you wish to remove. If you
wish to reauthorize your computer for that license you must reinstall the original license and reathorize the
computer.
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Troubleshooting

Why is this cue broken? / Why is this cue showing a red X? ( )

Hold your mouse over the broken cue and QLab will display a tooltip that describes why the cue is broken.

A broken cue has an incomplete or invalid parameter. You must fix the parameter before the cue will run. (Note
that a Group Cue is the exception to the rule that a broken cue will not run, because a Group Cue never really runs
in the first place. It just contains other cues. The non-broken cues in the group will run normally.)

I'm only getting audio out of my first two channels—what gives?

By default, a mono-channel sound file will only be routed out of the first channel of your audio device, and a stereo
sound file will only go out of the first two channels.

To customize the routing for your audio, select your Audio Cue and go to the "Levels" tab in the inspector. Use the
crosspoint knobs to route the file's audio channels to each desired output channel of the device.

My audio is dropping out / glitching after 2 seconds.

The buffer for Audio Cues holds two seconds of audio data. A dropout or glitch after two seconds usually means that
the hard disk had been put to sleep by the operating system, and is not yet ready to supply more audio data by the
time the two second buffer has been used up.

This problem can usually be fixed by changing your system preference to prevent the system from putting hard
disks to sleep. Go to System Preferences → Energy Saver → "Put the hard disk(s) to sleep when possible" and make
sure this is NOT checked.

In some cases an external hard disk may not honor this setting, and put itself to sleep after a period of inactivity. In
this case you may wish to put in silent "dummy" cues that are fired prior to when you need to make sure the disk is
up and running at full speed. The silent cue can be any small, simple audio file with no sound that can be used to
force a disk awake.

After QLab displays a series of still images, it starts to slow down or
even crash

Make sure you're stopping old still image video cues that you don't need to run any more.

Video cues that display still images will remain running until explicitly stopped. Even if they are no longer visible
(for example, if another still image is covering them), they are loaded and consuming resources. It is important to
stop old still image video cues that you do not need anymore, so that their resources can be released.
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